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EXempty Exercise 1. Bluemix and the Cloud Foundry 
command-line interface (CLI)

What this exercise is about

In this exercise, you sign on to Bluemix and create an application. You run 
the application from a web browser. Next, you install the Cloud Foundry 
command-line tool, download the starter package to the workstation, and 
extract the package. You then connect to Bluemix from the command line 
and redeploy the application to Bluemix.

What you should be able to do

After completing this exercise, you should be able to:

  • Sign on to Bluemix from a browser session 

  • Create a Bluemix application from an existing template

  • Add a service to the application from the service catalog

  • Test the application with the resource endpoint after the application is 
started 

  • Follow the “getting started” option on Bluemix to use the CLI

  • Install the Cloud Foundry CLI

  • Download the package

  • Sign on to Bluemix from the CLI

Introduction

IBM Bluemix is an open-standard, cloud platform for building, running, and 
managing applications. With Bluemix, you focus on rapidly building 
compelling user experiences with flexible compute options, choice of 
DevOps tools, and a powerful set of IBM and third-party APIs and services. 
Learn how to quickly set up and deploy your first Bluemix application that is 
developed on your own workstation.

Requirements

To complete this exercise, you must install the Cloud Foundry command-line 
interface on a compatible Microsoft Windows workstation. For a list of 
compatible operating systems, see: 
https://github.com/cloudfoundry/cli
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Exercise instructions

Preface

This exercise depends on the availability of the IBM Bluemix cloud and connectivity from your own 
workstation to the cloud environment.

Part 1: Set up your IBM Bluemix account

You must sign up and create your IBM Bluemix and IBM Bluemix DevOps Services accounts before 
you start this exercise. The IBM Bluemix account provides a runtime environment for your IBM SDK 
for Node.js application.

Important

Complete the steps in the tutorial to sign up for an IBM Bluemix and IBM Bluemix DevOps Services 
account with your IBM ID. Review the “Getting Started with Bluemix and Bluemix DevOps Services 
with Node.js” tutorial.

https://hub.jazz.net/tutorials/jazzeditor/

Part 2: Explore the dashboard

The IBM Bluemix dashboard is the web application interface to your online account. Through the 
dashboard, you can manage memory and resource settings for your services and applications. In 
this section, log in and explore the dashboard.

__ 1. Open the IBM Bluemix website (http://bluemix.net) in a web browser.

__ 2. Log on to IBM Bluemix.

__ a. In the IBM Bluemix home page, click Log in.

__ b. Enter your IBM ID and password.

__ c. Select Sign in.
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EXempty __ 3. Examine the dashboard.

__ a. From the IBM Bluemix menu, click Dashboard.

Note

The IBM Bluemix website uses a responsive design interface: the web page layout changes 
according to the web browser size. For smaller displays, the website hides the menu items in a 
menu.

If you do not see the Dashboard link, increase the width of your web browser window.

__ 4. Examine the computing infrastructure for your application.

__ a. In the IBM Bluemix dashboard, examine the infrastructure types that are available to 
you.

IBM Bluemix supports three types of infrastructure:

  - Cloud Foundry technology provides a computing infrastructure for your server 
runtime environments, services, and applications. IBM Bluemix takes care of the 
management and maintenance of the infrastructure that runs your applications.

  - IBM Containers provide more fine-grained control over the computing infrastructure 
than run your application and services. A container is an object that holds everything 
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that your applications require to run. You can use and extend public images from the 
IBM Bluemix catalog. You can also use images from the public Docker hub.

IBM containers run Docker containers in a hosted cloud environment. Docker adds 
an engine to deploy an application to the virtual environment. Docker also provides 
an environment to run your application.

  - A virtual machine is a software implementation of a computer that runs applications 
like a real workstation. You can configure the operating system, server runtime 
environment, and application.

You can deploy and manage your virtual machines with the Bluemix user interface or 
OpenStack API from the cloud.

Note

In this exercise, you focus on building an application on a Cloud Foundry infrastructure. For more 
information about the IBM Container and virtual machine infrastructures, see the corresponding 
lectures in the course.

__ b. View your IBM Bluemix Cloud Foundry environment health.

The Cloud Foundry section of the dashboard displays the memory available for 
applications and services. The dashboard also displays the number of services that are 
running in the environment. In the middle of the dashboard, the App Health indicator 
shows you whether one or more applications stopped running.

The amount of memory and the number of services available to you depends on your 
IBM Bluemix subscription.

Note

Depending on the number of applications and services in your account, your environment health 
dashboard might not match the screen capture in this step.
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EXempty __ 5. Examine the list of applications and services in your IBM Bluemix account.

__ a. Locate the search bar for applications and services at the upper-right corner of the 
dashboard.

__ b. Change the dashboard view to a list view.

__ c. Examine the list of applications and services.

Applications are programs that you develop in the IBM Bluemix Cloud Foundry 
environment. You build your application to run on one of the runtime environments from 
Cloud Foundry.

Services are pre-built components for your applications. For example, analytics 
packages, databases, and mobile frameworks are some of the services from IBM 
Bluemix.

Part 3: Create an application

The IBM Bluemix catalog lists components and services that help you build your application. In this 
part, create an IBM Bluemix application with the IBM SDK for Node.js run time.

__ 1. Open the IBM Bluemix catalog.

__ a. In the IBM Bluemix website, click Catalog from the menu bar.
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__ 2. Examine the boilerplate, runtime, and services in the catalog.

__ a. Examine the list of boilerplate catalog items.

Boilerplates are packages of sample applications with the Bluemix services. When you 
select a boilerplate, IBM Bluemix configures the services on which the application relies. 
IBM Bluemix also provides you with the source code and documentation for the sample 
application.

__ b. Examine the list of runtime environments in the catalog.

To create your own application, select the server runtime environment as a starting 
point. You are responsible for setting up the IBM Bluemix services for your application.

The runtime environments that IBM supports are listed as “IBM” runtimes. The 
“community” runtimes rely on open source projects that external groups manage.
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EXempty __ c. Examine the list of IBM Bluemix services in the catalog.

Services are extensions to the cloud environment that IBM Bluemix hosts. The service 
provides functions that are ready-for-use by the app's running code. The predefined 
services that are provided by Bluemix include database, messaging, push notifications 
for mobile apps, and elastic caching for web apps.

Bluemix simplifies the use of services by provisioning new instances of the service, and 
binding those service instances to your application. IBM Bluemix manages the services 
for you.

__ 3. Create an application with an instance of the IBM SDK for Node.js runtime environment.

__ a. Switch to the IBM Bluemix dashboard view.

__ b. Scroll down to the Applications section.
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__ c. Click Create an app.

__ d. The application wizard prompts whether you want to build a web application or a mobile 
application. Click Web.

__ e. On the next page, you choose a starting point for your project in the application wizard. 
You can create an empty application space with a server runtime environment. You can 
also select an application buildpack that you created or a sample application. 
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EXempty Click SDK for Node.js.

__ 4. Examine the plan details for the SDK for Node.js runtime environment.

__ a. The SDK for Node.js page describes the qualities the cost for hosting the runtime 
environment. For more details on the pricing, click View Details in Catalog.
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__ b. Examine the plan pricing details.

The plan explains the charges for using the cloud environment. In this example, IBM 
Bluemix provides a no-charge service under a threshold. After the unit-hour threshold, 
your IBM Bluemix account is charged at a price that depends on how much memory 
your application uses per hour.

In this example, the pricing in the Canada region is $0.074 Canadian dollars for each 1 
GB used per hour. The service plan pricing depends on the runtime environment, your 
region, and your account type.

__ c. Examine the environment details for the SDK for Node.js runtime environment.

The space represents the deployment environment within your IBM Bluemix account. In 
this example, dev represents a development sandbox for your IBM Bluemix applications.
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EXempty The name and host settings represent a unique identifier for your application. Make 
sure that the host name is unique across all applications in the mybluemix.net domain.

__ d. Set the name to <your-user-id>-nodesample, where <your-user-id> is your own unique 
IBM ID.

Information

You can set the name and host value to any unique name across the mybluemix.net domain. 
Make sure that you use the same value for the rest of this exercise.

__ e. Set the host name to the same value as name.

__ f. Select the Default service plan.

__ g. Click Create.

__ 5. Examine the options for developing the Bluemix application.

The application wizard describes three options for developing your Bluemix application:

You can develop the application on your own local workstation and deploy the code to your 
Bluemix application space. Securely log in to your IBM Bluemix account with the Cloud 
Foundry command-line interface, or CF. Deploy the application from your workstation to 
your IBM Bluemix account with this tool.

If you want to develop your application on your local workstation through an integrated 
development environment (IDE), download the Eclipse Tools for Bluemix. You can deploy 
your local application within Eclipse instead of command-line tools.

The IBM Bluemix account also supports Git repositories: a popular source code 
management system. Either link your organization’s Git repository server, or use IBM 
Bluemix DevOps services to host the repository on your behalf.

Note

In this exercise, you build an application with the Cloud Foundry command-line interface on your 
computer workstation. In the following exercises, you explore the two other options: creating an IBM 
Bluemix application with the Eclipse tools for Bluemix, and managing your application with a Git 
repository on IBM Bluemix DevOps services.
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__ 6. Install the Cloud Foundry command-line tools on your own workstation.

__ a. Examine the instructions for coding a Bluemix application with the CF command-line 
interface.

Information

You can also view the instructions for installing the CF command-line interface from the IBM 
Bluemix documentation:
https://www.ng.bluemix.net/docs/#starters/install_cli.html

__ b. Download the command-line interface.

__ c. Install the command-line interface on your workstation.

__ d. Create a directory to hold the source code for your application.

__ e. Open a command prompt (Microsoft Windows) or terminal (Mac OS, Linux).

__ f. Enter cf --version to confirm that the command-line interface runs correctly.

cf --version

Windows

Example:

C:\IBM\Bluemix> cf --version
cf version 6.10.0-b78bf10-2015-02-11T22:26:25+00:00
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EXempty
Note

For more information about Mac OS and Linux versions of the Cloud Foundry command-line 
interface, see the IBM Bluemix documentation.

__ 7. Download and extract the sample application.

__ a. In the Start coding with the command-line interface documentation web page, click 
Download Starter Code.

__ b. Confirm that you downloaded a file that is named <your-user-id>-nodesample.zip, 
where <your-user-id> is the name of your IBM ID.

__ c. Extract the contents of the file in a source code directory for your application.

__ 8. Connect to IBM Bluemix with the CF command-line interface.

__ a. In a command prompt (Microsoft Windows) or terminal (Mac OS, Linux), change to the 
directory with the sample code.

__ b. Connect to the IBM Bluemix server with the command-line interface.

cf api https://api.ng.bluemix.net

Windows

Example: 

C:\IBM\Bluemix> cf api https://api.ng.bluemix.net
Setting api endpoint to https://api.ng.bluemix.net...
OK
API endpoint:   https://api.ng.bluemix.net (API version: 2.19.0)
Not logged in. Use 'cf login' to log in.

__ 9. Log in to your IBM Bluemix account.

__ a. Log in to your IBM Bluemix account with the command-line interface.

cf login -u <your-user-id> -o <your-organization> -s dev
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Important

When you run the login command, you must provide your IBM ID in <your-user-id> and the Bluemix 
organization to which your account belongs in <your-organization>.

Windows

Example: 

C:\IBM\Bluemix> cf login -u warrenf@ca.ibm.com -o warrenf@ca.ibm.com
-s dev

API endpoint: https://api.ng.bluemix.net

Password>
Authenticating...
OK

Targeted org warrenf@ca.ibm.com
Targeted space dev

API endpoint:   https://api.ng.bluemix.net (API version: 2.19.0)
User:           warrenf@ca.ibm.com
Org:            warrenf@ca.ibm.com
Space:          dev

__ 10. Upload and deploy the sample application into your Bluemix application.

__ a. Push the contents of the current directory to the IBM Bluemix application 
<your-user-id>-nodesample.

cf push <your-user-id>-nodesample
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EXempty
Windows

Example: 

C:\IBM\Bluemix>cf push warrenf-nodesample
Using manifest file C:\IBM\Bluemix\manifest.yml

Updating app warrenf-nodesample in org warrenf@ca.ibm.com / space dev as 
warren@ca.ibm.com...
OK

Using route warrenf-nodesample.mybluemix.net
Uploading warrenf-nodesample...
Uploading app files from: C:\IBM\Bluemix
Uploading 19.5K, 12 files
Done uploading
OK

Stopping app warrenf-nodesample in org warrenf@ca.ibm.com / space dev as 
warren@ca.ibm.com...
OK

Starting app warrenf-nodesample in org warrenf@ca.ibm.com / space dev as 
warren@ca.ibm.com...
-----> Downloaded app package (20K)
-----> Downloaded app buildpack cache (4.4M)
    -----> Node.js Buildpack Version: v1.14-20150309-1555
-----> Requested node range:  0.10.*
-----> Resolved node version: 0.10.36
-----> Installing IBM SDK for Node.js from cache
-----> Checking and configuring service extensions
-----> Restoring node_modules directory from cache
-----> Pruning cached dependencies not specified in package.json
-----> Installing dependencies
-----> Caching node_modules directory for future builds
-----> Cleaning up node-gyp and npm artifacts
-----> No Procfile found; Adding npm start to new Procfile
-----> Building runtime environment
-----> Checking and configuring service extensions
-----> Installing App Management
-----> Node.js Buildpack is done creating the droplet

-----> Uploading droplet (14M)

0 of 1 instances running, 1 starting
0 of 1 instances running, 1 starting
1 of 1 instances running
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App started

OK

App warrenf-nodesample was started using this command 
`./vendor/initial_startup.rb`

Showing health and status for app warrenf-nodesample in org 
warrenf@ca.ibm.com / space dev as warrenf@ca.ibm.com...
OK

requested state: started
instances: 1/1
usage: 256M x 1 instances
urls: warrenf-nodesample.mybluemix.net
last uploaded: Fri Feb 30 22:01:44 +0000 2015

     state     since                    cpu    memory          disk          
details
#0   running   2015-02-30 06:02:42 PM   0.0%   47.5M of 256M   43.9M of 1G

__ 11. Confirm that your sample application is running.

__ a. Open http://<your-user-id>-nodesample.bluemix.net/ in a web browser.

__ b. Confirm that the sample application appears.

__ c. Close the web browser.

End of exercise
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EXempty Exercise review and wrap-up

The first part of the exercise explored the IBM Bluemix dashboard and catalog through your 
account. In the second part of the exercise, you created a Bluemix application with the IBM SDK for 
Node.js runtime environment. After installing the Cloud Foundry command-line interface, you 
deployed the sample application from your local workstation to your Bluemix account.
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EXempty Exercise 2. Developing Bluemix applications with 
Eclipse

What this exercise is about

In this exercise, you work with the Eclipse development environment with the 
IBM Eclipse Tools for Bluemix plug-in. You learn what is needed to install and 
configure Eclipse for developing Bluemix applications.

What you should be able to do

After completing this exercise, you should be able to:

  • Download the Eclipse and required plug-ins for developing Bluemix 
applications on Eclipse

  • Configure Eclipse to work with Bluemix

  • Push applications from Eclipse to Bluemix

  • View Bluemix log files

Introduction

The Eclipse integrated development environment is an open source desktop 
program for designing, developing, testing, and managing applications. 
Eclipse supports several popular web application programming languages 
and platforms, including Enterprise Java and the IBM SDK for Node.js.

In this exercise, import the IBM Bluemix sample application that is written in 
the IBM SDK for Node.js into an Eclipse workspace. Examine the sample 
application source code. Install the Eclipse Tools for Bluemix and deploy the 
sample application to your IBM Bluemix account.

Requirements

You must complete the previous exercise in this course. Specifically, you 
must create an IBM Bluemix application with the IBM SDK for Node.js server 
run time. Also, you require a copy of the sample application that is written for 
the IBM SDK for Node.js.
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Exercise instructions

Preface

This exercise depends on the availability of the IBM Bluemix cloud and connectivity from your own 
workstation to the cloud environment.

Part 1: Before you begin

Before you begin this exercise, you must complete the steps in the previous exercise. You created 
an IBM SDK for Node.js application in your IBM Bluemix account, and you downloaded the sample 
application to your workstation.

Part 2: Install Eclipse for Java EE Developer Bluemix Tools

Eclipse is an open source integrated development environment (IDE). With this application, you can 
design, develop, test, and deploy server applications. Eclipse supports the IBM SDK for Node.js 
and WebSphere Application Server Liberty runtime environments on IBM Bluemix.

In this section, download and install Eclipse for Java EE Developer on your workstation. Add the 
Eclipse tools for IBM Bluemix to the IDE.

__ 1. Open the IBM Bluemix website in your web browser.

__ a. Open http://www.bluemix.net in a web browser window.

__ 2. Log in to your IBM Bluemix account.

__ a. Click Log in.

__ b. Enter your IBM ID and password.

__ c. Click Sign in.

__ d. Confirm that your IBM Bluemix account page is displayed.
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EXempty __ 3. Review the instructions for installing the Eclipse Tools for Bluemix.

__ a. From the navigation bar, click Docs.

__ b. In the search bar, enter for the term Eclipse

__ c. Press Enter.

__ d. Open the article that is named “Start coding with Eclipse Tools”.

Information

The IBM Bluemix documentation is the most up-to-date resource for working with your account. If 
the steps outlined in the article are different from the lab exercise instructions, follow the steps in the 
article.

__ 4. Download and install the Eclipse Tools for IBM Bluemix.

__ a. From the “Start coding with Eclipse Tools” article, click the link to the Eclipse for Java 
EE Developers application package.

__ b. Download Eclipse for Java EE Developers.

__ c. Extract Eclipse for Java EE Developers into your local workstation.

Important

You must install a Java runtime environment (JRE) in your workstation before you start Eclipse. For 
more information about where to download and install the Java JRE, see: 
https://www.java.com/en/download/
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__ 5. Start Eclipse for Java EE Developers.

__ a. Go to the directory with your copy of Eclipse for Java EE Developers.

__ b. Run Eclipse.

__ c. In the workspace launcher dialog box, enter a directory to store your application source 
files.

Important

Keep your application source code in a separate directory from your Bluemix application files. In 
this example, the Eclipse for Java EE Developers application is installed in C:\IBM\Eclipse. The 
workspace for the application source code is stored in C:\IBM\Eclipse\workspace.

__ d. Click OK.

__ 6. Install the Eclipse Tools for IBM Bluemix.

__ a. In the “Start coding with Eclipse Tools” webpage, click and hold the Install button.

__ b. Drag the installation button onto the Eclipse IDE toolbar.
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EXempty __ c. In the Eclipse Marketplace dialog box, select IBM Eclipse Tools for IBM Bluemix.

__ d. Click Confirm.

__ e. Review the software licenses for the IBM Eclipse Tools for Bluemix. You must accept the 
license terms to install the software.

__ f. Click Finish.

__ g. Confirm that the wizard completed successfully.
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__ 7. Create a server profile for your IBM Bluemix account in the Eclipse Servers view.

__ a. From the main menu bar, switch to the Java EE perspective.

__ b. Examine the Servers view. There are currently no entries in the view.

__ c. Click No servers are available. Click this link to create a new server.

__ d. In the “Define a new server” wizard, expand the IBM folder.

__ e. Select IBM Bluemix as the server type.

__ f. Click Next.
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EXempty __ g. On the “IBM Bluemix Account” page, type your IBM ID and password for the Bluemix 
account.

__ h. Click Validate Account. IBM Bluemix verifies that the IBM ID and password are correct.

Note

If the account validation fails, make sure that your IBM ID and password entries are correct for your 
account. You can verify your Bluemix account credentials through your web browser: 
http://bluemix.net

__ i. Click Finish.

Part 3: Import the IBM Bluemix sample application to your Eclipse 
workspace

Copy the contents of the sample IBM SDK for Node.js application that you retrieved in the last 
exercise. Examine the source code for the sample application in the Eclipse integrated 
development environment.

__ 1. Create a project to hold the contents of your IBM Bluemix application.

__ a. From the main menu bar, click File > New > Project.
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__ b. On the “Select a wizard” page, select General > Project.

__ c. Click Next.

__ d. Enter <your-ibm-id>-nodesample as the name of the project. Replace <your-ibm-id> 
with the name of your IBM ID account.

__ e. Click Finish.

__ 2. Import the IBM SDK for Node.js sample application into your workspace.

__ a. From the Project Explorer view, select the project for your Bluemix application.

__ b. From the main menu bar, click File > Import.
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EXempty __ c. In the Import wizard, select General > Archive File as the source file.

__ d. Click Next.

__ e. In the From archive file field, select the sample application compressed file. You 
downloaded the sample application in Exercise 1.

__ f. Click Finish.
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Part 4: Examine the sample application

In this part, examine the sample application in your Eclipse workspace. The sample application 
runs on the IBM SDK for Node.js server runtime environment. It uses the Express web application 
framework as a web application solution.

__ 1. Examine the Bluemix sample application for the IBM SDK for Node.js.

__ a. In the Project Explorer view, expand the <your-ibm-id>-nodesample project.

__ b. Open app.js.
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EXempty __ c. Examine the app.js source code in the editor.

/*jshint node:true*/

//-----------------------------------------------------------------------
// node.js starter application for Bluemix
//-----------------------------------------------------------------------

// This application uses express as its web server
// for more info, see: http://expressjs.com
var express = require('express');

// cfenv provides access to your Cloud Foundry environment
// for more info, see: https://www.npmjs.com/package/cfenv
var cfenv = require('cfenv');

// create a new express server
var app = express();

// serve the files out of ./public as our main files
app.use(express.static(__dirname + '/public'));

// get the app environment from Cloud Foundry
var appEnv = cfenv.getAppEnv();

// start server on the specified port and binding host



Student Exercises

Course materials may not be reproduced in whole or in part 
without the prior written permission of IBM.

2-12 Cloud Application Development on Bluemix © Copyright IBM Corp. 2015

app.listen(appEnv.port, appEnv.bind, function() {

// print a message when the server starts listening
  console.log("server starting on " + appEnv.url);
});

The app.js is the main entry point for the sample IBM SDK for Node.js application. The 
sample application uses two modules: express.js and cfenv. The Express web application 
framework sets up an app JavaScript object to represent the web application. By default, the 
Node.js language provides lower-level HTTP objects to handle the interaction between the 
client and the server.

The Cloud Foundry environment module provides programmatic access to the environment 
variables from your IBM Bluemix account.

The HTML main welcome page is in the /public directory.

In the last line of the screen capture, the app.use(...) function configures the routes of the 
HTTP express object. The function reads the index.html file and returns the web page in 
the HTTP response message.

__ 2. Examine the HTML web pages for the sample application.

__ a. Expand the public folder in the Project Explorer view.
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EXempty __ b. Open index.html.

<!DOCTYPE html>
<html>

  <head>
    <title>NodeJS Starter Application</title>
    <meta charset="utf-8">
    <meta http-equiv="X-UA-Compatible" content="IE=edge">
    <meta name="viewport" content="width=device-width, initial-scale=1">
    <link rel="stylesheet" href="stylesheets/style.css">
  </head>

  <body>
    <table>
      <tr>
        <td style= "width:30%;">
          <img class = "newappIcon" src="images/newapp-icon.png">
        <td>
            <h1>Hi there!</h1>
          <p>Thanks for creating a
            <span class = "blue">NodeJS Starter Application</span>.
            Get started by reading our
            <a href = "https://www.ng.bluemix.net/docs/#starters/nodejs/
            index.html#nodejs">documentation</a>
            or use the Start Coding guide under your app in your dashboard.
    </table>
  </body>
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</html>

The index.html web page writes a message to the body of the webpage. It also provides a 
link to the IBM Bluemix documentation on the IBM SDK for Node.js run time.

Part 5: Publish and test the sample application

Before you edit the sample application, deploy and test the application to your IBM Bluemix account 
development (dev) environment. The Eclipse tools for Bluemix added your IBM Bluemix account as 
a remote server in your Eclipse workspace.

__ 1. Define the <your-ibm-id>-nodesample application type as an IBM SDK for Node.js 
application.

__ a. In the Project Explorer view, right-click <your-ibm-id>-nodesample.

__ b. Click Properties.

__ c. In project properties, select the Project Facets category.
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EXempty __ d. Click Convert to faceted form.

__ e. Select the Node.js Application facet.

__ f. Click OK.

Note

To avoid creating two applications with the same name, remove the existing 
<your-ibm-id>-nodesample application that you created in the previous exercise.

You can also overwrite the contents of the existing <your-ibm-id>-nodesample application. Map 
the existing project with an IBM Bluemix application.

Select the IBM Bluemix application and synchronize the contents with the project in the local 
workspace.

__ 2. Remove the existing sample application from your IBM Bluemix account.

__ a. In the servers view, right-click the IBM Bluemix server.
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__ b. Click Remove.

__ c. Click OK to confirm the remove action.

__ 3. Add the <your-ibm-id>-nodesample application to your IBM Bluemix account.

__ a. Right-click the IBM Bluemix server in the servers view again.

__ b. Click Add and remove.
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EXempty __ c. Click Add All.

__ d. Click Finish.

__ e. In the Application Details wizard, leave the project name as the IBM Bluemix application 
name.

__ f. Click Next.

__ g. On the “Launch deployment” page, make sure that the Memory limit (MB) is set to the 
default value of 512 MB.
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__ h. Review the Launch deployment details, including the web address for the web 
application.

__ i. Click Finish.

__ 4. Verify that the Eclipse tools successfully deployed the sample application to your IBM 
Bluemix account.

__ a. Examine the Console view. The Eclipse tools for Bluemix reports the deployment status 
in this view.

__ b. Confirm that the tool successfully deployed the sample application to IBM Bluemix.
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EXempty __ 5. Open the web address for the sample application.

__ a. In a web browser, go to http://<your-ibm-id>-nodesample.mybluemix.net. Replace 
<your-ibm-id> with your own IBM ID account name.

__ b. Confirm that the sample index page is displayed in your browser.

__ c. Close the web browser.

__ 6. Close Eclipse.

End of exercise
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Exercise review and wrap-up

In the first part of the exercise, you installed the Eclipse integrated development environment (IDE) 
on your own computer. After installing the Eclipse tools for Bluemix, you set up a connection 
between your local workspace and your remote IBM Bluemix account.

In the second part of the exercise, you imported the sample application for IBM SDK for Node.js 
into your Eclipse workspace. You examined the source code for the application, and you deployed 
the application to your previously created IBM Bluemix application.
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EXempty Exercise 3. Developing Bluemix applications with 
IBM Bluemix DevOps services

What this exercise is about

In this exercise, you work with IBM Bluemix DevOps Services to explore, 
develop, build, and deploy Bluemix applications.

What you should be able to do

After completing this exercise, you should be able to:

  • Sign in to DevOps

  • Explore public projects in DevOps

  • Sign in to Bluemix and DevOps

  • Create a Git repository in DevOps Services to manage your source code

  • View and edit code in DevOps

  • Build and deploy code from DevOps to Bluemix

  • Test the application in Bluemix

Introduction

The IBM Bluemix DevOps service provides a set of online development tools. 
When you create a project for your application, DevOps services sets up a 
source code repository compatible with the Git API. In the Build and Deploy 
mode, you can commit and restore files in your project. You can also use 
your own Git client.

DevOps service also provides a rich integrated development environment 
(IDE) for developing, testing, and deploying IBM SDK for Node.js 
applications right in your web browser. The Edit Code mode provides you 
with syntax highlighting and API reference features that you expect in a 
desktop application.

Requirements

You must complete the previous exercise in this course. Specifically, you 
must create an IBM Bluemix application with the IBM SDK for Node.js server 
run time. Also, you require a copy of the sample application that is written for 
the IBM SDK for Node.js.
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Exercise instructions

Preface

This exercise depends on the availability of the IBM Bluemix cloud and connectivity from your own 
workstation to the cloud environment.

Part 1: Before you begin

Before you begin this exercise, you must complete the steps in the previous exercise. You created 
an IBM SDK for Node.js application in your IBM Bluemix account, and you downloaded the sample 
application to your workstation.

Part 2: Examine the IBM Bluemix application

In this part, explore the application overview page in your IBM Bluemix account. The overview page 
lists the status of your application and the resources that it uses. Set up a source code repository to 
manage the artifacts that make up your Bluemix application.

__ 1. Open the IBM Bluemix website in your web browser.

__ a. Open http://www.bluemix.net in a web browser window.

__ 2. Log in to your IBM Bluemix account.

__ a. Click Log in.

__ b. Enter your IBM ID and password.

__ c. Click Sign in.

__ d. Confirm that your IBM Bluemix account page appears.

__ 3. Open the application page for your sample application.

__ a. In the IBM Bluemix dashboard, scroll down to the Applications section.
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EXempty __ b. Click <your-ibm-id>-nodesample, the application that you created in the previous 
exercise.

__ c. Set the memory quota to 512 MB memory.

__ d. Confirm that your application is in the running state.

__ 4. Test the sample application.

__ a. Click the routes link for your application.

__ b. Check to see that the browser opens the NodeJS starter application web page.
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__ c. Close the NodeJS starter application web page.

Important

If you already created a Git repository on IBM Bluemix DevOps Services for the sample application, 
you must delete the Git repository before you continue with this exercise.

__ 5. Create a Git Repository for the starter application source code.

__ a. On the <your-ibm-id>-nodesample application page, click Add Git.

__ b. Select Populate the repository with the starter application package and enable 
Delivery Pipeline (Build & Deploy).

__ c. In the Create Git Repository wizard, click Continue.



Student Exercises

Course materials may not be reproduced in whole or in part 
without the prior written permission of IBM.

© Copyright IBM Corp. 2015 Exercise 3. Developing Bluemix applications with IBM Bluemix 3-5

V10.1

EXempty
Note

In the first lab exercise, you created the <your-ibm-id>-nodesample Bluemix application. You also 
downloaded a copy of the NodeJS starter application source code to your workstation. Upload the 
source code into the Git repository for the application.

__ d. Wait until the wizard creates the Git repository for your application.

__ e. Confirm that the wizard completed successfully.

__ f. Click Close.

Part 3: Review the Git repository for your application

Before you import the source code for the application, examine the features of the IBM Bluemix 
DevOps project that manages the artifacts for your application.

__ 1. Open the Git repository for your application.

__ a. On the Bluemix application page, examine the Git URL link.

Information

The IBM Bluemix DevOps service hosts a source code repository that supports the Git API. You can 
use any Git client to work with the artifacts that are stored in the repository.

__ b. Click Edit Code to open the IBM Bluemix DevOps service web application.
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__ 2. Open the project overview page for your application.

__ a. Click <your-ibm-id>-nodesample to open the project overview page.

__ 3. Examine the IBM Bluemix DevOps service web application.

__ a. Review the IBM Bluemix DevOps services project overview page.

The overview page lists your IBM account as the owner of the Git repository. In this 
exercise, the repository is empty except for a license file and a readme file.
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EXempty __ b. Open the readme.md document.

The readme file provides a quick summary to the repository that manages your 
application artifacts and source code. It is a suggested practice to provide an up-to-date 
description of your project in this document, especially for projects that are publicly 
shared for all users.

Information

The readme file is written with the Markdown syntax, a lightweight markup language for annotating 
plain text documents to be displayed as HTML documents. For more information about Markdown, 
see http://daringfireball.net/projects/markdown/

__ 4. View the project members for your application.

__ a. Click Members from the navigation bar.
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__ b. Examine the list of members for the <your-ibm-id>-nodesample project.

Note the lock icon beside the file folder for the project. By default, your DevOps project 
is private. The project has one registered member: your IBM ID. You are also the owner 
of the project.

__ 5. Examine the Git repository log.

__ a. Click Git log from the navigation bar.

__ b. Examine the commit log for the <your-ibm-id>-nodesample Git repository commit log.

The Create Git Repository wizard that you started from the IBM Bluemix account sets up 
a Git repository for your application. The wizard adds the sample license and readme file 
into the repository. The initial commit action has a unique identifier, the user name, and 
the date stamp.
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EXempty Part 4: Import the sample application

In the second exercise, you set up a sample IBM Bluemix application for IBM SDK for Node.js. 
Examine the contents of the application in the Git repository.

__ 1. Examine the sample application in your Bluemix DevOps services project.

__ a. Click Edit Code under the IBM Bluemix DevOps service site navigation bar.

__ b. Confirm that a set of files and directories appear in the project.

__ 2. Examine the IBM Bluemix DevOps Services Edit Code mode.

__ a. Examine the five options for the Edit Code mode.
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  - The Edit option provides a graphical editor to manage and update project files.

  - With the Git repository option, you can select and check-in files from the project 
into the Git repository.

  - The Console option displays the directories of your project.

  - The Applications option lists the deployment options for the application to your IBM 
Bluemix account.

  - The Settings option shows the customization options for the Bluemix DevOps 
Services integrated development environment.

__ b. Click app.js from the project directory.

Examine the contents of the app.js source code in the editor.

The editor in the web application provides the same features as the desktop Eclipse 
application: syntax highlighting, static code analysis of the JavaScript code, and a 
preview of the document.
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EXempty __ c. Place your cursor beside the word express in var app = express().

__ d. Press Ctrl + Space bar on your keyboard.

The code completion feature in the JavaScript editor supports node JavaScript modules 
and the standard JavaScript functions.

__ 3. Examine the HTML templates for the sample application welcome page.

__ a. In the project directory, expand the public folder.

__ b. Click index.html.
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__ c. Examine index.html in the editor.

The built-in editor also highlights and validates HTML web page markup. 

__ d. Select the sentence in line 18.

__ e. Change the phrase to “Hello node sample!”.

__ f. Press Ctrl + S to save your changes.

To view the effects of the source code changes, deploy and test your application on your IBM 
Bluemix account. In the next section, you save your changes to the Git repository before pushing 
the changes to your IBM Bluemix application.
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EXempty Part 5: Commit your changes to the Git repository

Commit the source code, configuration files, and other artifacts to the Git repository in your IBM 
Bluemix DevOps project. Deploy the changes to your application from the Git repository to the 
application in your IBM Bluemix account.

__ 1. Switch to the Git Repository option in the Edit Code mode.

__ a. In the navigation bar in the Edit Code mode, click Git Repository.

__ 2. Add and commit the changes in the project to the Git repository.

__ a. Examine the Working directory changes pane on the right side. The working directory 
changes window lists the files that you added or modified to the workspace.

__ b. Enter Updated index page title. in the comment window.

__ c. Select the Select All check box to highlight all the files.

__ d. Click Commit to save the files into the Git repository.

__ e. Examine the Working Directory Changes view on the left side.
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__ f. Confirm that there are no more updated files to commit from the working directory.

You can revert to the last saved version of your source code in the Git repository.

Part 6: Deploy the application from the Git repository to IBM Bluemix

There are two ways to deploy an application from your IBM Bluemix DevOps services project to 
your IBM Bluemix account: deploy from the Git repository, and deploy directly from your project.

If more than one developer is working on a DevOps services project, consider checking in your 
changes and pushing the most recent revision from the Git repository.

__ 1. Deploy the updated application from the Git repository to your IBM Bluemix account.

__ a. In the Outgoing section beneath Working Directory Changes, select Push All.

__ b. Switch to the Build & Deploy mode.
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EXempty __ c. Examine the delivery pipeline. Wait until the build and deploy tasks complete 
successfully.

__ d. Switch to the “Git repository” page.

__ e. Confirm that there are no more changes to push from the IBM Bluemix DevOps services 
project.
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__ 2. Examine the application dashboard for the <your-ibm-id>-nodesample application.

__ a. From your IBM Bluemix DevOps services web page, switch to the edit mode.

__ b. Click Application Dashboard from the server toolbar.

__ c. In the IBM Bluemix application dashboard, open the routes link: 
http://<your-ibm-id>-nodesample.mybluemix.net

__ d. Confirm that the sample application web page states “Hello node sample!”

Part 7: Deploy the application directly from your project workspace to 
IBM Bluemix

IBM Bluemix DevOps Services also supports publishing changes from your development project to 
a server environment on IBM Bluemix. With this technique, you can quickly test changes to your 
code on an actual Bluemix account.

__ 1. Edit the message in the sample application web page.

__ a. In the IBM Bluemix DevOps service website, switch to the Edit Code mode.
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EXempty __ b. Open index.html in the public folder.

__ c. In line 18, change the heading to “Welcome to the sample application!”

__ d. Press Ctrl + S to save your changes.

__ 2. Deploy the application directly from your project workspace.

__ a. In the server toolbar, click Deploy.

__ b. DevOps Services prompts whether you want to stop and redeploy the Bluemix 
application. Click OK to confirm the operation.

__ c. Wait until the environment finishes restarting and deploying the application.

__ 3. Confirm that the changes appear in the application.

__ a. Click the Application URL toolbar button to view the changes to your application.



Student Exercises

Course materials may not be reproduced in whole or in part 
without the prior written permission of IBM.

3-18 Cloud Application Development on Bluemix © Copyright IBM Corp. 2015

__ b. Verify that the updated heading appears in the sample application web page.

Part 8: Automatically push changes from your DevOps service project 
to IBM Bluemix 

With the stop and redeploy option, you must manually trigger an application restart through the 
server toolbar. Although this option is more convenient than having to commit your changes to the 
Git repository, it can be disruptive to your software development workflow for minor changes.

The Bluemix Live Sync feature automatically pushes any saved changes in the project workspace 
to a linked IBM Bluemix application. With IBM SDK for Node.js applications, you can update static 
files and view the updates on IBM Bluemix without restarting your application.

__ 1. Enable the live edit feature.

__ a. Beside the servers toolbar, click LiveEdit.

__ b. Click OK to redeploy the application and enable live edit mode.

__ c. Confirm that the live edit mode is enabled.

__ d. Verify that the IBM Bluemix application is running in a live edit mode.

__ 2. Change the sample application web page heading.

__ a. Open the index.html web page.
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EXempty __ b. Edit the heading to read “Welcome to the live edit sample application!”

Note

With the live edit feature, you do not need to save your static files. IBM Bluemix DevOps Services 
pushes the changes to your IBM Bluemix account automatically.

Examples of static files include HTML web pages and CSS stylesheets.

__ 3. Confirm that the changes appear in your IBM Bluemix application.

__ a. Click the Application URL toolbar button to view the changes to your application.

__ a. Verify that the updated heading appears in the sample application web page.

__ 4. Log out of IBM Bluemix and IBM Bluemix DevOps services.

__ 5. Close your web browser.

End of exercise
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Exercise review and wrap-up

In the first part of the exercise, you set up an IBM Bluemix DevOps service project to manage your 
Bluemix application. You imported the sample application that is written for the IBM SDK for Node.js 
server run time.

In the second part of the exercise, you saved your changes into the Git repository. Through the 
Build and Deploy mode, you pushed your committed source code changes to your IBM Bluemix 
application.

In the last part of the exercise, you deployed your changes directly from the project workspace. You 
also used the Bluemix Live Sync feature to push changes to static files without restarting the 
application.
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EXempty Exercise 4. Bluemix with Cloudant

What this exercise is about

In this exercise, you work with a Bluemix node application that includes a 
Cloudant DB service. You see how to work with a Bluemix Cloudant 
database from a JavaScript application and from the Cloudant console.

What you should be able to do

After completing this exercise, you should be able to:

  • Sign on to Bluemix

  • Add a Node.js Cloudant web starter application from the Bluemix 
boilerplates

  • Download the application package to the workstation

  • Review the application source code

  • Push the application to Bluemix

  • Connect to Cloudant

  • Create a database

  • Add data to the database

  • Access the Cloudant console and documentation

  • List the databases and get the data

  • Test the application to see that the data is added

Introduction

In an earlier exercise, you created an SDK for the Node.js Bluemix 
application.

You also installed the Cloud Foundry CLI on your local workstation. Later, 
you also installed the Eclipse development environment and the Bluemix 
plug-in for Eclipse.

In this exercise, you create another Node.js application with the Cloudant 
NoSQL DB service from a Bluemix boilerplate template.

Requirements

You must have an IBM Bluemix account and must complete exercises 1 and 
2 before doing this exercise.
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Exercise instructions

Preface

This exercise depends on the availability of the IBM Bluemix cloud and connectivity from your own 
workstation to the cloud environment.

Part 1: Sign on to the Bluemix cloud

From your web browser, type the address bluemix.net. Then, sign on to IBM Bluemix with your 
IBM ID and password.

When you are signed on, you see the application that you created earlier in the Bluemix catalog. 

Part 2: Add a Node.js application with a Cloudant DB service

In this part, you add the Node.js application with the Cloudant DB service and Monitoring and 
Analytics service from the Bluemix services boilerplate.

__ 1. Add the Node.js Cloudant DB Web Starter to your Bluemix environment.

__ a. From the Bluemix main page, click the Catalog tab.
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EXempty __ b. From the Boilerplates section of the Catalog, click Node.js Cloudant DB Web Starter.

__ c. In the Create an App area for the Web Starter application, type this information and click 
Create:

  • Name: Your application name

  • Host: same as above

  • Domain: mybluemix.net

  • SDK for Node.js: Default

  • Cloudant NoSQL DB: Shared



Student Exercises

Course materials may not be reproduced in whole or in part 
without the prior written permission of IBM.

4-4 Cloud Application Development on Bluemix © Copyright IBM Corp. 2015

  • Monitoring and Analytics: Free

Important

The name of your node application differs from the name that is shown in the figures of this 
exercise. Each application must have a unique name in IBM Bluemix. Use the naming convention 
that you decided on in the earlier exercises.

The Web Starter application is successfully installed.
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EXempty __ d. Click the option to return to the Blueprint Dashboard. After a short while, the application 
is started and you see the started Node.js application with the Cloudant DB service and 
the Monitoring and Analytics service.

__ e. You can click the routes link for the application to test that the application runs correctly.

__ 2. Because this exercise uses only the Node.js application and Cloudant DB service, you can 
delete the Monitoring and Analytics service.

__ a. From the menu at the upper right of the application, click Stop app.
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__ b. Now delete the Monitoring and Analytics service.

__ c. Confirm that you want to delete the service.

Deleting the services returns unused resources to your Bluemix account.

__ d. Leave the application in the stopped state on Bluemix.
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EXempty Part 3: Review the service environment variables

A number of environment variables are created for you when you added and bound the service to 
your application.

__ 1. Review and export the VCAP_SERVICES environmental variables.

__ a. From the dashboard, click the application icon.

__ b. From the navigation pane, click Environment Variables.
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__ c. The VCAP_SERVICES environment variables are displayed in the window.

These environment variables contain important data that you need for accessing the 
Cloudant database.

__ 2. Export the VCAP_SERVICES variables.

__ a. Click Export.
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V10.1

EXempty __ b. In the dialog box that opens, you can either open the JSON file with the editor, or save 
the variables to a file for later use.

__ c. The VCAP_SERVICES environment variables are shown in an editor.

These variables are used when you access the Cloudant database.
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Part 4: Review the starter application on the workstation

In this part, you download and review the application on the workstation.

__ 1. Download the starter code for the node application from the Bluemix environment.

__ a. After selecting the Node.js starter application in Bluemix, click Start Coding. Then, click 
Download Starter Code.

__ b. Save the file on your workstation.

__ 2. Start Eclipse if it is not already started.

__ 3. Create a project in Eclipse.

__ c. From the menu, click File > New> Project.

__ d. In the New Project dialog box, click General > Project. Then, click Next.

__ e. In the Project name field, type the name that is identical to the name that you gave the 
application on Bluemix.

__ f. Click Finish.

__ 4. Import the starter code into Eclipse.

__ a. Right-click the project that you created in the Project Explorer and click Import. 

__ b. Expand General, select Archive File, and click Next.
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V10.1

EXempty __ c. Browse to the directory where the starter package is downloaded to. Ensure that all the 
files are selected and click Finish.

__ d. Select Yes To All to overwrite ‘package.json’ in the folder for the project.

__ e. You see the files in the Project Explorer.
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__ 5. Change the project in Eclipse to make it recognizable to Bluemix as a Node.js project.

__ a. In the Project Explorer, right-click the project and click Properties.

__ b. In the Properties dialog box, select Project Facets. Then, click the option Convert to 
faceted form.
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EXempty __ c. In the Project Facets area, select Node.js Application.

__ d. Click Apply. Then, click OK.
The project is now set as a Node.js application and can be published to the IBM Bluemix 
server.

__ 6. Review the source code. The package that was created with the Node.js and Cloudant Web 
App starter boilerplate in Bluemix includes the source code to add a Cloudant database and 
data to the database.

__ a. Expand the project in the Project Explorer.

__ b. Double-click package.json to open it in the Eclipse editor. 
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__ c. You see that the application runs a script with the command node app.js.

The application also has dependencies that include the Express framework and 
Cloudant.

__ d. Close package.json.

__ e. In the Project Explorer, double-click manifest.yml.

__ f. In the editor, you see the name of the application and that the application has a Cloudant 
service.

__ g. Close manifest.yml.
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EXempty __ h. In the Project Explorer, double-click app.js. The file contains the JavaScript code for 
accessing the Cloudant DB service.

Notice the database name in the source code. This database is added to Cloudant the 
first time that the application runs.

__ i. Scroll down in the code and you see the initDBConnection() function. In addition to the 
database name, the host, port, user, password, and URL properties are all populated 
from the process.env.VCAP_SERVICES variable. This code demonstrates how the 
Node.js application reads the environment variables that you reviewed earlier in this 
exercise.

if(process.env.VCAP_SERVICES) {
var vcapServices = JSON.parse(process.env.VCAP_SERVICES);
if(vcapServices.cloudantNoSQLDB) {

dbCredentials.host = vcapServices.cloudantNoSQLDB[0].credentials.host;
dbCredentials.port = vcapServices.cloudantNoSQLDB[0].credentials.port;
dbCredentials.user = vcapServices.cloudantNoSQLDB[0].credentials.username;
dbCredentials.password = 

vcapServices.cloudantNoSQLDB[0].credentials.password;
dbCredentials.url = vcapServices.cloudantNoSQLDB[0].credentials.url;

}
console.log('VCAP Services: '+JSON.stringify(process.env.VCAP_SERVICES));

}
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Part 5: Run the application on Bluemix

In this part, you push the application from the workstation and run it on Bluemix.

The IBM Eclipse Tools for Bluemix is installed in an earlier exercise. The IBM Bluemix server is 
displayed to the list of servers on the Servers tab in the Eclipse workbench.

__ 1. Start the IBM Bluemix server.

__ a. If the IBM Bluemix server is not already started, start it from the Servers tab in Eclipse.

__ b. When started, you can expand the IBM Bluemix option to see the applications that are 
running on Bluemix. Because the application with the same name is stopped on Bluemix 
itself, you do not see it in the list of started applications on the IBM Bluemix server.

Important

If you see the application with the same name as the project in the list of applications that are 
running on the Bluemix server, you should delete the project in the servers view, or in the Bluemix 
cloud. Then, you can re-create it from Eclipse as described in the next steps.

You might need to delete the project in the Bluemix cloud first, if any of the dialog boxes in the next 
step are not automatically displayed.

__ 2. Deploy the application to Bluemix from the workstation.

__ a. In the Servers view, right-click the IBM Bluemix server. Then, click Add and Remove.
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EXempty __ b. In the Add and Remove dialog box, select the project in the left pane. Then, click Add.

__ c. The project is displayed in the right pane. Click Finish.

__ d. An Application details dialog box is displayed. Accept the default values, then click Next.
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__ e. In the Launch deployment dialog box, accept the default values, then click Next.

__ f. In the Services selection, select the service to bind to the application and click Finish.
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EXempty __ g. You see some activity in the Eclipse console.

__ h. After a short while, you see that the application is running in the Bluemix dashboard.

__ i. In the Eclipse console you see a message that the database might not be created as it 
exists.

The error is displayed because the application tried to add the my_sample_db that 
exists.
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__ j. You also see that the application is deployed in the Servers view of Eclipse.
You can now stop and start the application from the Servers view.

Part 6: Access the Cloudant documentation

In this part, you review the Cloudant documentation. 

In particular, you look at the application programming interfaces (APIs) for accessing Cloudant 
databases and data. Although you are not changing the JavaScript application, reviewing the 
documentation gives you a better understanding of the code in the sample application.

A number of environment variables are created for you when you added and bound the service to 
your application.

__ 1. From the Bluemix dashboard, click the application to display the details.

__ 2. If you click Environment Variables, you see that these values are the same as you saw 
earlier.
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EXempty __ 3. Review Cloudant documentation in Bluemix.

__ a. From the navigation pane, click Cloudant NoSQL DB.

The Cloudant Dashboard is displayed.
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__ b. Go to the bottom of the first page. Then, click Learn under the Getting Started title.

Alternatively, from another browser session, you can go to the address 
https://cloudant.com/cloudant-ibm-bluemix-tutorials-and-demos/

__ c. From the Cloudant tutorials page, click the For Developers tab, then click Reading and 
Writing.

You can also get to this page by typing 
https://cloudant.com/for-developers/crud/ in a browser tab.

__ d. You can review the documentation for reading and writing to a Cloudant database 
without signing in.
When your review of the documentation is completed, click the browser tab for the 
Bluemix Cloudant Dashboard.
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EXempty Part 7: Explore the features of the Cloudant console

In this part, you explore the Cloudant database from the Cloudant console.

__ 1. Open the Cloudant console.

__ a. From the Cloudant dashboard, click Launch.

__ b. The Cloudant console opens in a new browser tab. Notice that the database named 
my_sample_db exists.

You are now logged in to the Cloudant console with the default user that was generated 
when the Node.js and Cloudant was created.

__ 2. View the data in the database.

__ a. Click the my_sample_db link. Notice that there is one document in the database.

Note

If there are no documents in the database, logout from IBM Cloudant and relaunch the Cloudant 
console from the Cloudant dashboard.
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The page displays all the documents in the database.

The fields “_id” and “_rev” are generated fields. At this stage, all that you are seeing are 
the generated key and revision values.

__ b. Click the Edit icon for the document to open it with the editor.

You now see the rest of the JSON name-value pairs for the document.

The document editor provides a number of options for modifying the JSON document.

__ c. Click Cancel to exit without making any changes.
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EXempty __ 3. Review the database permissions.

__ a. On the Databases tab, with the my_sample_db selected, click Permissions.

You see the Cloudant users and permissions for the database.

Notice that the generated Cloudant user has full permission to access the database. 
This user is the same user that is signed in to the Cloudant dashboard and is the value 
for the username in the VCAP_SERVICES environment variable.
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__ b. You are free to explore the other features of the Cloudant console, including the 
Documentation tab.

__ c. Click Logout when you are finished reviewing the Cloudant console.

Part 8: Run the Bluemix Cloudant application

In this part, you run the Bluemix application.

__ 1. Run the application in a browser.

__ a. From the IBM Bluemix dashboard, click the routes link to run the application.
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V10.1

EXempty The application is displayed in a new browser tab.

Notice the sample_doc and the text “A sample Document”. These two text strings are 
the name-value pair that is stored in the Cloudant database that you saw earlier.

__ b. Click the information icon that is found at the upper left of the application.

The text describes how to add, edit, and delete categories to the application and the 
underlying Cloudant database.
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__ 2. Add some data to the Cloudant database.

__ a. Click the ‘+’ icon in the browser window to add a new category.

__ b. In the row that is added, type a title and description for the resource that you are adding.

__ c. Click Browse.
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EXempty __ d. Go to the file that you want to upload from your workstation.

__ e. Click Upload to select a file to upload.

The file is uploaded and stored on the Cloudant database.

Part 9: Verify the data from the Cloudant console

In this part, you verify that the data is added from the Cloudant dashboard.

__ 1. Explore the contents of the Cloudant database.

__ a. From IBM Bluemix, open the Cloudant console as you did earlier.
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__ b. On the Databases tab of the Cloudant console, notice that the number of documents 
that are stored in the Cloudant database is now 2.

__ c. Click the my_sample_db link to open the database.

__ d. Select the document that was added last. The latest document might be displayed first 
in some cases. Then, click the Edit icon.
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EXempty The details of the JSON document that is stored on the Cloudant database are 
displayed.

__ e. Click the View Attachments tab and the file name to display the contents of the 
attachment.

End of exercise
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Exercise review and wrap-up

In this exercise, you worked with the Node.js Cloudant web starter application from the Bluemix 
boilerplates to explore how a Node.js JavaScript application can access a Cloudant database.
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EXempty Exercise 5. Building a mobile data Bluemix 
application

What this exercise is about

In this exercise, you work with a Bluemix mobile data project. 

You create the Bluemix Mobile Data cloud component from a Blueprint 
boilerplate that includes a number of services.

You clone a sample client application from DevOps that is implemented as an 
Android application. 

You download the Bluemix Android SDK Java archive files and import the 
files into Eclipse so that the mobile application can integrate with the Mobile 
Data application that runs on Bluemix.

Finally, you test the client web application in an Android emulator that 
connects to the Mobile Data application that runs on the Bluemix cloud. 

What you should be able to do

After completing this exercise, you should be able to:

  • Sign in to Bluemix

  • Create a mobile data project in Bluemix

  • Set up the Android development environment in Eclipse

  • Clone the mobile application from IBM Bluemix DevOps

  • Configure the mobile BlueList application in Eclipse

  • Review the Android Java code

  • Install the Android virtual device

  • Run the BlueList Android application

  • Review the data on the Bluemix cloud

Introduction

This exercise is based on the IBM DeveloperWorks article titled “Building an 
Android app using the IBM Mobile Data for Bluemix cloud service”. The 
article is found at the address:

http://www.ibm.com/developerworks/library/
mo-android-mobiledata-app/index.html

http://www.ibm.com/developerworks/library/mo-android-mobiledata-app/index.html
http://www.ibm.com/developerworks/library/mo-android-mobiledata-app/index.html
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Requirements

You must have an IBM Bluemix ID and must complete the previous exercises 
before doing this exercise.

In these earlier exercises, you installed the Cloud Foundry CLI on your local 
workstation. You also installed the Eclipse development environment and the 
Bluemix plug-in for Eclipse.
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EXempty Exercise instructions

Preface

This exercise depends on the availability of the IBM Bluemix cloud and connectivity from your own 
workstation to the cloud environment.

Part 1: Sign on to the Bluemix cloud

From your web browser, type the address bluemix.net. Then, sign on to IBM Bluemix with your 
IBM ID and password.

When you are signed on, you see the applications that you created earlier in the Bluemix catalog. 

Part 2: Create a Mobile Data application on Bluemix

In this part, you create the Mobile Data Cloud application from the Bluemix services boilerplate.

__ 1. Add Mobile Cloud to your Bluemix environment.

__ a. From the Bluemix main page, click the Catalog tab.

__ b. From the Boilerplates section of the Catalog, click Mobile Cloud.



Student Exercises

Course materials may not be reproduced in whole or in part 
without the prior written permission of IBM.

5-4 Cloud Application Development on Bluemix © Copyright IBM Corp. 2015

The Mobile Cloud boilerplate includes a Node.js run time and a number of services.

__ c. In the Create an App area for the mobile cloud application, type or select the following, 
with the unique naming convention that you adopted in the earlier exercises and click 
Create:

  • Name: Your application name

  • Host: same as above

  • Domain: mybluemix.net

  • SDK for Node.js: Default

  • Mobile Application Security: Default

  • Push: Standard

  • Mobile Data: Shared
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EXempty   • Mobile Quality Assurance: Standard plan

The Mobile Data application and its four services are created.

The application runs on the IBM Bluemix cloud. Later, you create an Android mobile application on 
your workstation by cloning the code from IBM DevOps services.

Part 3: Download the Bluemix Android SDK to the workstation

In this part, you download the Android SDK from the Bluemix Mobile Data application.

__ 1. Open the instructions for downloading the Mobile Cloud Services Android SDK for IBM 
Bluemix.

__ a. From a browser tab, type 
https://hub.jazz.net/project/bluemixmobilesdk/
ibmbluemix-android/overview
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__ b. Follow the instructions in the readme.md file for downloading the Mobile Cloud Services 
Android SDK for IBM Bluemix.

__ c. The compressed file for the SDK can be downloaded from 
https://mbaas-catalog.ng.bluemix.net/sdk/
ibm-bluemix-sdk-android.zip or search the IBM Bluemix documentation at 
https://www.ng.bluemix.net/docs/#starters/mobile/index.html for the 
Mobile Cloud SDK for Android.

__ d. Save the file to a folder on the workstation.

__ e. Extract the compressed file to a folder on the workstation.

You see a number of Java Archive files and text files.

__ f. Later, you import these Java Archive files into your project in Eclipse.
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EXempty Part 4: Set up the Android development environment

This exercise uses the Eclipse Android Developer Tools (ADT) as the developer environment. You 
can use the Android Developer Studio instead of the Eclipse ADT. However, instructions are only 
provided for getting the Android mobile client to work on the Eclipse ADT.

__ 1. Install the Eclipse ADT plug-in.

__ a. From the Eclipse menu, click Help > Install New Software.

__ b. In the Install dialog box, click Add.

__ c. In the Add Repository dialog box, type or select the following input values and click OK:

  • Name: ADT plug-in

  • Location: https://dl-ssl.google.com/android/eclipse/
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__ d. Select Developer Tools on the page.

__ e. Click Next.

__ f. Accept the defaults on the next page, then click Finish.

__ g. Click OK in the Security Warning dialog box that warns that you are installing software 
that contains unsigned contents. 

The Android Developer Tools plug-in is installed.

__ h. Restart Eclipse when the restart Eclipse prompt is displayed.

__ 2. Install the Android SDK.

__ a. After Eclipse is restarted, you are prompted to configure the Android SDK. Select Install 
new SDK.
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EXempty __ b. Select Install the latest available version of Android APIs.

__ c. Click Next.

__ d. Accept the license. 

__ e. Click Install.

The Android SDK is installed to the target location.

__ 3. Install the Android APIs that the BlueList application requires.

__ a. In Windows Explorer, go to the target location where the Android SDK is installed. In the 
case of the example that is seen earlier, the location is at 
C:\Users\IBM_ADMIN\android-sdks.

__ b. From the tools subdirectory, double-click SDK Manager.exe to run the SDK Manager.

Note

If you are running Eclipse Luna, you can run the command from the menu. 
Click Window > Android SDK Manager.

__ c. From the Android SDK Manager, select all the packages for Android 4.3.1 (API 18).
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__ d. Install the packages and any updates that the Android SDK Manager selects.

The packages are installed.

__ e. Close the Android SDK Manager.

__ 4. Configure the Android preferences in Eclipse.

__ a. From the Eclipse menu, click Window > Preferences.
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EXempty __ b. Select Android. The list of SDK target APIs is displayed. 

__ c. Click OK. 

The Eclipse environment is now set up to run Android applications.

Part 5: Download and configure the Android BlueList mobile 
application

In this part of the exercise, you clone the sample application from IBM DevOps services directly to 
the Eclipse workspace. Then, you configure the mobile application to access the IBM Bluemix 
Mobile Data application that you defined earlier in the exercise.

__ 1. Perform a Git clone in Eclipse.

__ a. From the Eclipse main menu, click File > Import.
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__ b. On the Select page of the Import wizard, select Git > Projects from Git.

__ c. Click Next.

__ d. On the Select Repository Source page, select Clone URI.
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EXempty __ e. Click Next.

__ f. On the Source Git Repository page, type the following values and click Next:

  • URI: https://hub.jazz.net/git/mobilecloud/bluelist-mobiledata

  • Host: hub.jazz.net

  • Repository path: /git/mobilecloud/bluelist-mobiledata

__ g. On the Branch Selection page, leave the default values (master selected).
Click Next.

__ h. On the Local Destination page, leave the default values.
Click Next.

__ i. On the “Select a wizard to use for importing projects” page, leave the default values 
(import existing projects).
Click Next.

__ j. On the “Import projects from a Git repository” page, ensure that the project is selected.
Click Finish.

You now see the project in the Project Explorer.
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Note

There are some errors in the Java code of the project. These errors are fixed next.

__ 2. Add a libs folder to the project.

__ a. Right-click the bluelist-android-mobiledata project in the Project Explorer. Then, click 
New > Folder.

__ b. Type libs for the folder name.

__ c. Click Finish. The folder is added to the project hierarchy.

__ 3. Import the Java archive files from the Mobile Cloud Services Android SDK for IBM Bluemix 
that you downloaded earlier into the libs folder.

__ a. In the Project Explorer, right-click the libs folder. Then, click Import.

__ b. In the Import dialog box, select File System under the General option. 

__ c. Click Next.

__ d. On the “File system” page, click Browse alongside the From directory.

__ e. Go to the folder into which you extracted the Mobile Cloud SDK for Android.
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EXempty __ f. Select ibmbluemix.jar, ibmdata.jar, and ibmfilesync.jar.

__ g. Click Finish.

The files are imported into the libs folder.

__ 4. Configure the Java build path for the project.

__ a. In the Project Explorer, right-click the bluelist-android-mobiledata project, then click 
Build Path > Configure Build Path.

__ b. Click the Libraries tab in the Properties dialog box.

__ c. Click Add JARs.
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__ d. Add each of the JARs from the libs folder. 
When complete, the Java Build Path dialog box includes the three JARs on the build 
path.

__ e. Click OK.

There are no errors in the bluelist-android-mobiledata project.

__ 5. Update the bluelist.properties file with the applicationID, applicationSecret, and 
applicationRoute values.

__ a. From the Dashboard in the IBM Bluemix browser window, click the application that you 
created at the start of the exercise.
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EXempty __ b. Click Mobile Options. 

You see the registration credentials for the Bluemix application. There is an option to 
copy each of these values to the clipboard.

__ c. In the bluelist-android-mobiledata project in Eclipse, expand the assets folder. Then, 
double-click bluelist.properties to open it with the editor.

__ d. Paste the values for each of the properties into the editor. Do NOT include string 
quotation marks around the values.

Example values are shown in the figure.

__ e. Save the changes.

__ f. The application is now ready to run.
But first, you should review the Java code for the Android application.
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Part 6: Review the Android Java code

Now you review the Java code for the mobile application.

Android mobile applications are written in Java. In this part of the exercise, you see the Java code 
that communicates between the mobile application that runs on an Android emulator on the 
workstation and the IBM Bluemix application in the cloud.

__ 1. Review the Android mobile application source code in Eclipse.

__ a. In the bluelist-android-mobiledata project, expand the src folder. 
Then, double-click BluelistApplication.java to open it with the editor.

You see the source code in the editor.

__ b. In the Outline view, click the onCreate() method.
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V10.1

EXempty The editor positions the source code at the onCreate() method.

Notice that the method reads the bluelist.properties file. Then, the code initializes 
the IBM Bluemix environment and the IBMData service.

__ c. You can optionally review the source code in the other Java files. When complete, close 
the files in the editor.

Part 7: Install the Android virtual device

This part of the exercise assumes that you installed the Eclipse ADT plug-in and the Android SDK 
and that there are no Android virtual devices defined.

If you already have Android devices that are defined, skip this section and go to the next part in the 
exercise.

__ 1. Add the Android virtual device in Eclipse.

__ a. Go to the directory where the Android SDK is installed on your workstation.

__ b. Double-click AVD Manager.exe.
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Note

If you do not find this file, run android.bat from the /tools directory where the Android SDK is 
installed on your workstation. Then, click Tools > AVD Manager.

It is a good practice to update the Android SDK to the latest version by using the android.bat 
utility.

__ c. Click the Device Definitions tab in the Android Virtual Device Manager dialog box.

__ d. Select a device such as Galaxy Nexus. Then, click Create AVD.
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V10.1

EXempty __ e. In the “Create new Android Virtual Device (AVD)” dialog box, ensure that the target 
matches the API level of the application.

__ f. Click OK.
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The device is added to the list of Android virtual devices.

Part 8: Run the BlueList Android application

In this part, you run the mobile BlueList application in an Android emulator from Eclipse.

The Android application the Mobile Data application that runs on IBM Bluemix and persists the data 
on a cloud database.

__ 1. Run the Android application in Eclipse.

__ a. From the Project Explorer, right-click the application, then click Run As > Android 
Application.
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V10.1

EXempty After a few moments, you see the Android emulator.

In the Eclipse console, you see that the Android application is being installed.
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__ b. After some time, the lock screen is displayed. Unlock the Android emulator by swiping 
the lock icon to the right.
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V10.1

EXempty Now you see the BlueList application in the emulator.

The BlueList mobile application is successfully started and is now communicating with 
the Mobile Data application on IBM Bluemix.

The Android log view in Eclipse displays some messages.
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__ 2. Type some data into the BlueList mobile application.

__ a. Type items into the grocery list, and click the plus icon to add the typed value to the list.

The item is displayed in the list.
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V10.1

EXempty The data items are persisted even when you rerun the mobile emulator.
The data is being stored on a cloud database.

Part 9: Review the data on the Bluemix cloud

Here, you review the data in the cloud.

__ 1. Sign on to Bluemix, if you are not already signed on.

__ 2. Select the application in the Dashboard view.

__ 3. Review the mobile data.

__ a. Click the Mobile Data service.

__ b. Click the Manage Data tab.

Notice that the current storage has a nonzero value, indicating that some data is stored.
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__ c. Expand Data Classes.

Notice that the Item row includes the number of items that were added to the BlueList 
mobile application.

__ d. Expand Item.

You see the item that you added in the BlueList Android application.

__ 4. Feel free to restart the Android mobile application and add, modify, or delete items in the list.
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V10.1

EXempty __ 5. To modify or delete an item in the Android emulator, swipe the list item to the left. An edit 
(pen) or delete (trash can) icon is displayed at the top of the emulator.

__ 6. If you delete the item it is removed from the list. Refresh the Bluemix browser and notice 
that the Item row is no longer displayed in the Data Classes area.

__ 7. In Bluemix, click the Analytics tab to see the analysis of the API calls by device.

End of exercise
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Exercise review and wrap-up

In the exercise, you created the Bluemix Mobile Data cloud component from a Blueprint boilerplate.

You downloaded the Android SDK to the workstation. You made a Git clone of a sample client 
Android application from DevOps and reviewed the code in Eclipse.

You installed the Android development environment. Next, you tested the application with an 
Android emulator that ran in Eclipse.

You reviewed the changes to the data that was persisted on a cloud database that runs on Bluemix.
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V10.1

EXempty Exercise 6. Extending the Bluemix mobile data 
application to access it from a mobile 
web application

What this exercise is about

In this exercise, you add a mobile web application that displays the Bluemix 
data list in a web browser. 

You download a sample application from Bluemix.

You change the sample application on your workstation so that it can access 
the Bluemix data service. 

You run and test the mobile web application on the workstation.

Finally, you push the application to Bluemix and run the mobile web 
application on Bluemix. 

What you should be able to do

After completing this exercise, you should be able to:

  • Install the necessary command-line software on the workstation

  • Download the sample mobile web application

  • Configure the mobile web application to work with the Bluemix mobile 
data application

  • Create a local instance of the mobile web application

  • Run the local instance of the mobile web application

  • Push the mobile web application to Bluemix

  • Test the mobile web application in Bluemix

Introduction

This exercise complements the IBM Mobile Data for Bluemix cloud service 
application that was created in an earlier exercise. The exercise adds a web 
front end that displays the data from the earlier application in a web browser.

Requirements

You must have an IBM Bluemix account and must complete the previous 
exercises before doing this exercise.



Student Exercises

Course materials may not be reproduced in whole or in part 
without the prior written permission of IBM.

6-2 Cloud Application Development on Bluemix © Copyright IBM Corp. 2015

Exercise instructions

Preface

This exercise depends on the availability of the IBM Bluemix cloud and connectivity from your own 
workstation to the cloud environment.

Part 1: Install the Node.js software

In the first part of the exercise, you get the mobile-web application to run on the workstation. To get 
the application to work on the local environment, you need to install the Node.js runtime 
environment and some node-dependent modules. You can install either the IBM Node.js SDK, or 
you can download and install the Node.js runtime environment from http://nodejs.org

In this part, instructions are given to install the IBM Node.js SDK.

__ 1. Verify that the Java Runtime Environment (JRE) works properly on your computer.

__ a. Open a command prompt in Microsoft Windows.

__ b. Run java -fullversion in the prompt.

__ c. Verify that the Java Runtime Environment (JRE) works properly.

java full version JRE 1.7.0 ...

__ d. If the command does not work, download and install the Java 7 Runtime Environment 
on your computer.

N

There are two versions of the Java Runtime Environment: 32-bit and 64-bit. Choose the version 
that matches your operating environment.

__ 2. Download a copy of the IBM SDK for Node.js.

__ a. Open the web page: www.ibm.com/developerworks/web/nodesdk/

__ b. Download the version of the IBNSDK for Node.js for your operating system.

__ 3. Install IBM SDK for Node.js on your computer.

__ a. Run the installer application.

__ b. Choose the installation directory for the installation.
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V10.1

EXempty __ c. Confirm that the IBM SDK for Node.js software is installed, and record the installation 
directory.

__ 4. Set up the environment variables for Node.js.

__ a. Open a command prompt in Microsoft Windows.

__ b. Run the nodevars script to set up the environment.

__ c. Confirm that the script configured the environment variables for Node.js.

C:\IBM\node]# nodevars.bat
Your environment has been set up for using Node.js 0.10.26 (x64) and npm.

N

Node comes with a version of npm installed. However, npm gets updated more frequently than 
Node does, so make sure that you have the latest version.

Part 2: Install Git software

In this part of the exercise, you install Git software.

__ 1. Check whether Git is already installed on your computer.

__ a. On a command line, type git version.
If a version of Git is displayed, skip this part, and go to the next part of the exercise.

__ 2. If Git is not installed, go to the Git website git-scm.com/downloads and download the 
Git version for your operating system.
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__ 3. Run the installation program executable file.

__ a. After downloading the file, start the installation executable program.

__ b. In the Git Setup wizard on the “Adjusting your PATH environment” page, select Use Git 
from the Windows Command Prompt.

__ c. Run through the remaining installation pages. You can leave the rest of the options as 
their default values.

__ 4. When Git is installed, verify that it works on a command line.

__ a. Type git version

You see the version that is installed displayed in the command prompt.

Part 3: Download and configure the sample mobile web project

In this part of the exercise, you download and extract the sample mobile web application.

__ 1. Sign in to your Bluemix DevOps services account. 
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EXempty In the browser, type: 
https://hub.jazz.net/project/mobilecloud/bluelist-mobiledata/overview

You see the bluelist-mobile data sample project.

__ 2. Download the sample.

__ a. From the DevOps services project, click the icon to download the entire project.
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__ b. Save the file on the local workstation.
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EXempty __ 3. Create a folder and extract the mobile web files.

__ a. Extract bluelist-mobiledata-mobileweb to the folder you created.

The files are extracted to the bluelist-mobiledata-mobileweb subfolder of your directory.

__ 4. In the bluelist-mobiledata-mobileweb subfolder, open README.md in a text editor.

The README.md text file describes the steps that are needed to get the application to work 
on the local workstation.
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__ 5. Configure the mobile web application to access the mobile data application on Bluemix.

__ a. Modify the bluelist.json file in the public directory to include the application ID, 
application secret, and application route for the Bluemix mobile data application that you 
created in the earlier exercise.

__ b. Save the changes.

Here is the example with completed values.

Part 4: Install other application-dependent software

In this part of the exercise, you install some additional software that is needed to run the sample 
mobile web application on your workstation.

__ 1. Install the prerequisite software on your workstation.

__ a. Open a command prompt in Microsoft Windows.

__ b. Change directory to the bluelist-mobiledata-mobileweb subfolder.

__ c. Ensure that the environment variables for Node.js are set up.

__ d. In the command prompt, type npm install --production
Because npm was installed by default with Node.js earlier, you are obtaining the latest 
version.

__ e. From the same directory, install the bower dependency manager. 
Type npm install -g bower
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V10.1

EXempty The bower and angular software dependencies are installed.

Part 5: Run the mobile web application on the workstation

In this part, you run the Node.js application on the workstation.

__ 1. Run the Node application on the workstation.

__ a. From the command prompt, in the bluelist-mobiledata-mobileweb directory, type node 
app

The command prompt displays a message that the application is started.



Student Exercises

Course materials may not be reproduced in whole or in part 
without the prior written permission of IBM.

6-10 Cloud Application Development on Bluemix © Copyright IBM Corp. 2015

__ 2. View the mobile web client in the browser.

__ a. Open a browser session, then type http://localhost:3000

The mobile web client is displayed in the browser.

The data in the list corresponds to the data that you typed in the earlier exercise.

Part 6: Deploy the mobile web application to Bluemix

In this part, you deploy the application to Bluemix so that the mobile web client can be run from 
Bluemix. The Cloud Foundry command-line option is already installed on your workstation in an 
earlier exercise.

__ 1. View the web page for the Bluemix application.

__ a. Open another browser tab with the URL that you used to replace the value of 
<INSERT_APPLICATION_ROUTE_HERE> earlier in the exercise.

The browser displays the web page for the Bluemix Mobile Data application.



Student Exercises

Course materials may not be reproduced in whole or in part 
without the prior written permission of IBM.

© Copyright IBM Corp. 2015 Exercise 6. Extending the Bluemix mobile data application to access 6-11

V10.1

EXempty __ b. The app.js on Bluemix specifies what the default Mobile Data application displays in the 
web browser. You can view the app.js file under Files and Logs on Bluemix.
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The existing public/index.html file displays the hello from the cloud text that you saw 
displayed earlier in the browser.

__ c. Next, you push a new app.js file from the workstation that displays the mobile web page 
as the default page for the bluelist Mobile Data application.

__ 2. Push the mobile web application to Bluemix.

__ a. From the command prompt, in the bluelist-mobiledata-mobileweb directory, type cf 
push ${yourAppName}
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EXempty __ b. In this case, replace ${yourAppName} with the unique name that you gave for the 
Mobile Data application when you created the application from the boilerplate on 
Bluemix.

The application is uploaded to Bluemix. The existing Bluemix application is stopped and 
restarted.

The instance of the Bluemix Mobile Data application is started.

__ 3. Review the default web page in the browser.

__ a. In your web browser, type the URL for the route address for the Bluemix Mobile Data 
application.
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You now see the web page for the bluelist-mobile-web application.

The landing page for the Bluemix Mobile Data application is changed to the bluelist web 
page.

__ b. You can modify the items on the page by dragging the item to the left. The page displays 
the options to delete or edit the item.
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EXempty __ c. If you click Edit, you can change the value in the list by typing a new value and clicking 
the Update Item button.

__ d. Swipe the row with Delete and Edit to the right to display the updated list.

End of exercise
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Exercise review and wrap-up

In the exercise, you download the bluelist-mobiledata-mobile application from Bluemix and you 
configure it to run locally on the workstation. The locally installed mobile web application 
communicates with the IBM Bluemix cloud to run Bluemix and data services.

Then, you push the application to Bluemix. The mobile web application replaces the landing page 
for the Bluemix Mobile Data application with the bluelist web page. Now the web client and the 
application both run on the IBM Bluemix cloud.

Finally, you test that the application works correctly on the IBM Bluemix cloud.


